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Dimensional Insight, Inc. disclaims the implied warranties of merchantability and fitness for a 
particular purpose and makes no express warranties except as may be stated in its written 
agreement with and for its customer.

In no event is Dimensional Insight liable to anyone for any indirect, special, or consequential 
damages. The information and specifications in this manual are subject to change without notice.

Copyright © Dimensional Insight, 1991-2012.

Microsoft®, Windows®, and Excel® are registered trademarks of Microsoft Corporation. 
Adobe®, Acrobat®, and Distiller® are registered trademarks of Adobe Systems Incorporated. 
AIX®, AS/400®, and DB2® are registered trademarks and iSeries is a trademark of International 
Business Machines Corporation. Other product and company names mentioned in this manual are 
the service mark, trademark, or registered trademark of their respective owners.

Dimensional Insight, Inc. (DII) is the owner of the Software to which this documentation applies. 
The Software is subject to copyrights, patents and other intellectual property rights of DII, is 
furnished only under a license to use it, and no ownership rights are conveyed in the Software 
under any circumstances. License rights are set out in written license agreements entered into by 
all licensees either prior to delivery of the Software or prior to first use of the Software. No use of 
the Software is permitted unless the user has first agreed to the terms of the license. DO NOT USE 
THE SOFTWARE IF YOU HAVE NOT REVIEWED AND AGREED TO THE TERMS OF THE 
LICENSE.

Limited Warranty and Liability.  THE SOFTWARE IS FURNISHED “AS IS” AND 
WITHOUT WARRANTY OF ANY KIND OR NATURE TO THE EXTENT PERMITTED BY 
APPLICABLE LAW.  DII EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, SATISFACTORY 
QUALITY AND NONINFRINGEMENT, AND THEIR EQUIVALENTS UNDER ANY LAW 
OF ANY JURISDICTION.  IF APPLICABLE LAW IMPLIES ANY WARRANTIES OR 
CONDITIONS WITH RESPECT TO THE SOFTWARE, ALL SUCH WARRANTIES OR 
CONDITIONS ARE LIMITED TO A PERIOD OF THIRTY (30) DAYS FROM THE DATE OF 
DELIVERY OF THE SOFTWARE TO THE LICENSEE.

DII DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE 
WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE 
WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE 
WILL BE CORRECTED.  FURTHERMORE, DII DOES NOT WARRANT OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
SOFTWARE IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.  SHOULD THE SOFTWARE PROVE DEFECTIVE, LICENSEE (AND NOT 
DII, ITS DISTRIBUTORS, DEALERS OR EMPLOYEES) WILL ASSUME THE ENTIRE 
COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.
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SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF EXPRESS 
OR IMPLIED WARRANTIES OR CONDITIONS UNDER CERTAIN CIRCUMSTANCES, SO 
THE ABOVE EXCLUSIONS MAY NOT APPLY TO YOU.  IF SUCH EXCLUSIONS DO NOT 
APPLY TO YOU, AND ONLY IN SUCH EVENT, YOUR SOLE REMEDY WILL BE, AT DII’S 
OPTION, REPAIR OR REPLACEMENT OF THE SOFTWARE OR A REFUND OF THE 
PRICE PAID BY YOU FOR THE SOFTWARE.  THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS.  YOU MAY ALSO HAVE OTHER LEGAL RIGHTS WHICH VARY FROM 
STATE TO STATE AND JURISDICTION TO JURISDICTION.

While efforts have been made to ensure THAT the program and its documentation are free from 
defects, under no circumstances and under no legal theory, whether tort, contract, or otherwise, 
shall DII, or its distributors, dealers or employees, be liable to you or any other person for any loss 
or damage sustained in connection with ANY ATTEMPT TO use the Software, including without 
limitation, any economic, consequential or other indirect loss or damage, even if DII has been 
previously advised of the possibility of such loss or damage. Some states and jurisdictions do not 
allow the exclusion or limitation of INCIDENTAL or consequential damages under certain 
circumstances, so this limitation and exclusion may not apply to you.

The Software may include certain cryptographic software that may be subject to export controls 
under the U.S. Export Administration Act. The Software may not be exported to any country or to 
any foreign entity or “foreign person” to the extent prohibited under applicable U.S. government 
regulations. By downloading or using the Software, you are acknowledging and agreeing to the 
foregoing limitations on your right to export or re-export the Software, and are also representing 
and warranting that you are neither on any of the U.S. government’s lists of export precluded 
parties nor otherwise ineligible to receive software containing cryptography that is subject to 
export controls under the U.S. Export Administration Act.

If a version of DiveLine that uses encryption is running, administrators must be aware that 
allowing users outside the United States to access data via certain DI-Clients qualifies as exporting 
encryption software (either the client executable or the Java applet sent to the browser). Export or 
re-export of encrypted software must be in accordance with the Export Administration 
Regulations. Diversion of encryption software contrary to U.S. law is prohibited.

Copyright © 2012 Dimensional Insight, Inc., 60 Mall Road, Burlington, MA 01803

(http://www.dimins.com)
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Chapter 1
Overview of 6.4 Changes 1

Introduction 1
This document outlines the new features available in version 6.4 of The Diver Solution™. It 
assumes the reader is already familiar with The Diver Solution 6.3 as a point of reference.

All Diver Solution 6.4 changes and features are listed below, and unless noted otherwise, are 
described in further detail in the remaining sections of this manual.

Additional features added since 6.4 (x) can be reviewed by downloading the 
Release Notes from DI-Download.

Solution Changes 1
• Handling Missing QuickView Values (page 2-1)

Diver Changes 1
• Menu & Toolbar Changes

— Save QuickView Sets... and Save Graph Template... added to File Menu (page 2-3)

— Save Excel Toolbar icon added (page 2-3)

— Save PDF Toolbar icon added (page 2-3)

• Graph Changes

— Gantt Charts added (page 2-3)

— Graph Templates added (page 2-9)
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Introduction DivePort Changes
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• Report Changes

— Keyboard shortcut to get to bottom of Reports added (page 2-10)

• QuickView Changes

— QuickView dialogs redesigned (page 2-11)

— QuickView Population Order options added (page 2-13)

— QuickView Load Value options added (page 2-14)

— List QuickViews added (page 2-17)

— Free Entry QuickViews added (page 2-20)

— Blank QuickView value added

— QuickView Sets added (page 2-20)

• QuickView Value support added to Advanced Find (page 2-22)

DivePort Changes 1
• General improvements for the administrator

— Page editing improved (page 3-2)

— Printing changes (page 3-4)

— Permissions changes (page 3-5)

— User interface enhanced (page 3-5)

• Image Portlet changes

— Document storage and organization improved (page 3-10)

— Image Portlet edit dialog changed (page 3-11)

— Hotspots added where mouse hover presents text (page 3-13)

• Measures Portlet changes:

— Change Dimension option added (page 3-16)

— Stacked columns added (page 3-17)

— Even row color added (page 3-19)

— PDF and Excel Click Actions added (page 3-20)

• Marker Portlet changes

— Change Dimension option added (page 3-16)

— Page Selector placement option added (page 3-8) 
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• Map Portlet Changes (see page 3-20)

• QuickView Portlet Changes (see page 3-21)

• Desktop mobile preview added (see page 3-22)

• Slope Indicator added (see page 3-23)

• Bookmarks added (see page 3-24)

• Custom Macros added (see page 3-25)

• New Portlet types 

— Table of Contents Portlet added (see page 3-26) 

— Lookup Manger Portlet added (see page 3-28)

— Document Display Portlet added (see page 3-30)

NetDiver Changes 1
• Advanced Find functionality added (page 3-33)

• Improved Console appearance
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Chapter 2
Diver Solution and Diver 
Changes 2

Diver Solution Changes 2
• Missing QuickView Handling

Handling Missing QuickView Values 2
In 6.4, when a Downlink in DivePort, or a ProDiver .dlk file has a QuickView value specified that 
is not present in the population of the QuickView in the Marker itself, Diver will create a 
temporary “Blank” value surrounded by angle brakcets (< >) to denote that it is temporary.

If multiple values are specified and some of them exist, the missing values will be added, but the 
QuickView will subset for only those values that exist. If none of the requested values exist, then 
an empty “Tabular Window Missing Group Data” window will result from that QuickView.

Selecting QuickView values other than those specified, will remove the temporary values from the 
population.
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Diver Changes 3
• Menu & Toolbar Changes

— Save QuickView Sets... and Save Graph Template... added to File Menu

— Save Excel Toolbar icon added

— Save PDF Toolbar icon added

• Graph Changes

— Gantt Charts added

— Graph Templates added

• Report Changes

— Keyboard shortcut to get to bottom of Reports added

• QuickView Changes

— QuickView dialogs redesigned

— QuickView Population Order options added

— QuickView Load Value options added

— List QuickViews added

— Free Entry QuickViews added

— Blank QuickView value added

— QuickView Sets added

• QuickView Value support added to Advanced Find
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Menu & ToolBar Changes 2
Diver 6.4 introduces new File Menu and Toolbar items.

File Menu Changes 2
Items are:

Toolbar Changes 2
Items are:

Use Window > Customize Toolbar... to add these buttons to your Diver toolbar.

Gantt Charts 2
A Gantt chart is a type of bar plot that illustrates Tasks that comprise the work breakdown 
structure of the project. Gantt charts can be used to show current schedule status using 
percent-complete shadings and a vertical “Today” line. Gantt charts allow you to display the 
following:

Table 2-1: New Diver Menu Items

Menu Item Description

Save Graph Template... Allows you to save custom graph options as a template for later use 
with other graphs. See Using Graph Templates on page 2-9 for 
additional information.

Save QuickView Set... Allows you to save the current QuickViews in a .qvs file. See 
QuickView Sets on page 2-20 for more information.

Table 2-2: New Diver ToolBar Buttons

Tool Icon Description

Save Excel Opens the Save window as... dialog with the CSV option already 
selected, allowing you to save the current dive window as a .csv 
file. Corresponds to the File > Save Window... CSV option.

Save PDF Opens the Save window as... dialog with the PDF option already 
selected, allowing you to save the current dive window as a .pdf 
file. Corresponds to the File > Save Window... PDF option.



2-4 Diver Solution and Diver Changes

Diver Changes Gantt Charts

6.4 CHANGES

• Task span, from a start point to an end point.

• Dependency, linking the end of one task to the start of another.

• Legend Category, allowing you to lump various tasks into different color-coded 
categories.

Gantt charts require a very specific Model layout. Models should be created as follows:

• One Dimension, which describes a list of task names.

• Two Summaries, one for task start and one for task end. These should be either 
numbers or dates.

• Optionally, you can also include the following Info Fields:

— Dependency, which lists the task name that connects from its end to the current row’s 
beginning.  For synchronization purposes, these two task values should be the same.

— Legend Category, which lists a name that will appear on the legend.  If this Info Field 
is defined, tasks will be color-coded to match the list of names included in this Info 
Field.

To create a Gantt Chart:
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1. Perform the desired dive. The example below shows a dive on Task Name, with 
Summary columns for Task Start and Task End, and Info Fields for Dependency and 
Category.

2. Click the Graph button to launch the Select Graph Type dialog.
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3. Select Time Graphs > Time Chart - Gantt Charts. Click Next >.
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4. Set the Task Start Column, Task Finish Column, Dependency Info Field (optional), 
and Legend Info Field (optional) data attributes as desired.
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Diver Changes Gantt Charts
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5. Click Graph Options to change additional graph attributes. In this example, the first 3 
Legend colors have been changed on the Legend tab, to represent the colors of the 3 
Categories defined in the data.



Using Graph Templates Diver Changes

Diver Solution and Diver Changes 2-9

6.4 CHANGES

6. Click OK to return to the Set Data Attributes dialog, and Finish to display the 
completed Gantt Chart, shown here.

This Gantt Chart shows each Task in the project, the start and end date for that Task, which Tasks 
are dependent on another Task (indicated by the connecting solid lines), and the resources required 
for each Task. Those tasks indicated in gray do not have an associated Category in the underlying 
data.

Using Graph Templates 2
Diver 6.4 introduces the ability to save a predefined Graph Template (.gtpl), to be used to apply 
uniform appearance options to your graph Markers. 

Not all Graph Options saved in the template apply to each Graph type available in Diver. If a Graph 
Option that does not apply to the selected Graph type has been saved in the Template, that option 
will be ignored when the Template is applied.

Any custom settings that are changed after a Graph Template is applied, will override the Graph 
Template settings.

To create a Graph Template:

1. Create any type of Graph and set each of the required Graph elements.
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2. Click the Graph Options... and set all Graph attributes as desired.

3. Select File > Save Graph Template....

4. Name the template as desired, and click Save.

To use a Graph Template:

1. Create any new Graph and set each of the required Graph attributes as desired.

2. Click Graph Options....

3. On the Appearance tab, browse to the saved Graph Template you wish to apply to the 
current graph. Click Open.

4. Click OK on the Graph options dialog.

5. Click Finish to display the Graph with the applied Template.

Paging to the End of a Report 2
Diver 6.4 introduces the ability to automatically page to the end of a Report or Report Palette by 
clicking Ctrl-End. This allows for ease of navigation to the end of a long Report, without use of the 
vertical scrollbar.

On some machines (typically laptops), you may need to click Ctrl-Fn-End.

QuickView Changes 3
Diver 6.4 introduces several QuickView improvements and changes, including:

• Improved QuickView Performance

• Improved Edit QuickView dialogs for Dimension and DiveBook QuickViews

• New QuickView types: List and Free Entry

• The ability to save QuickView sets. 

Each is described in further detail in the following sections.
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Improved QuickView Performance 2
Diver 6.4 QuickView performance has been improved, increasing the speed of QuickViews that 
normally populate slowly due to thier dependency settings. This results in improvements in the 
speed of some older Markers. Older Markers do not need to be updated to benefit from this 
performance enhancement.

Edit QuickViews Dialog Changes 2
In Diver 6.4, when you select Edit > Add/Edit Quickviews..., the Edit QuickViews dialog shows 
the list of existing QuickViews, as in previous versions of Diver, but instead of a single, generic 
“Add Quickview” dialog available for all QuickView types, there is now a series of “Add 
<Quickview Type>...” buttons:

• Add Dimension QuickView (page 2-12)

• Add DiveBook QuickView (page 2-15)

• Add List QuickView (page 2-17)

• Add Free Entry QuickView (page 2-20)

Click these buttons to display individualized Edit QuickView dialog boxes.

As previously mentioned, each type of QuickView now has its own edit dialog. In Diver 6.4, these 
dialogs have changed from a tabbed to a non-tabbed dialog, with subdialogs for editing limits and 
dependencies.
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A new button labeled Auto-Set Top-to-bottom Dependencies has also been added to the Edit 
QuickView dialog. Click this button to automatically set dependencies for all QuickViews listed in 
the Select QuickView pane, from least to most dependent. That is, QuickView dependencies are 
set from top to bottom. The first QuickView has no dependencies, the second is dependent on the 
first, the third is dependent on the first and second, etc.

Dependencies can still be edited for individual QuickViews using the Dependencies Edit... button 
(as shown in the upcoming QuickView dialog sections). This dialog is identical to the Dependency 
dialog in previous versions of Diver.

Dimension QuickViews 2

The Dimension QuickViews dialog, changed for Diver 6.4, is shown here:

It contains the following options:

• Name - the name of the QuickView. It will prevent you from creating a duplicate or 
blank name.

• Data Section - controls the data source and basic settings used for the QuickView.

— Source - the source for the Dimension QuickView values. The Options are: Standard 
(Classic Quickviews), Model (the new default), and External. These correspond to 
the various data sources available in 6.3 and earlier, however they are displayed 
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differently in 6.4. 

If you choose “Model” as the data source, you can also select the Model name from 
the Model pulldown (as shown in the image above). If you choose “External”, the 
Model pulldown is still displayed, and a Browse... button is added, allowing you to 
specify the file path to the external QuickView.

— Dimension - select or enter a Dimension name. A Refresh button is also displayed 
that will open the specified Model and repopulate the Dimension combobox pulldown 
with the Dimensions from the new Model. This option is displayed only if External 
has been selected from the Source pulldown

— Dependencies - specify the dependencies for the selected QuickView. Click Edit... to 
configure QuickView dependencies using the General dialog box. This dialog is the 
same as the “Dependencies” tab in Diver 6.3 and earlier.

— Population Order - specify the order that values will appear in the QuickView.

1. Click Edit... to open the Edit Population Order dialog box.

2. Check Include All Values to configure the QuickView to display an “All 
Values” QuickView entry for the selected Dimension. If checked, “All Values” 
will always appear first in the QuickView. This is the default.

3. Use the Dimension Values pulldown to determine the presence and sort order 
of Dimension Values in the QuickView. Choose one of the following: Sort Up 
(default) displays values in their default order; Sort Down displays values in 
reverse order, which can be useful when viewing date values to see the latest 
date first; Skip, removes Dimension values from the display.

4. Use the Named Groups pulldown to determine the presence and location of 
Named Groups in the QuickView. Choose one of the following: First, Last 
(default), or Skip. The order of multiple Named Groups in the QuickView is 
determined by the order they appear in the DivePlan. Named Groups cannot be 
sorted up or down like Dimension Values.

— Limits - allows you to include or exclude values in the Dimension QuickView. This is 
analogous to the “Values” tab in Diver 6.3 and earlier.
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• Display Section - controls the way the QuickView is displayed.

— Display Type - select from Pulldown, Picklist or Combobox. This is no longer the 
QuickView “Type”, as in 6.3 and earlier, rather an aspect of its display.

— Label Type - select the contents of the QuickView label. Choose from: the QuickView 
Dimension, the QuickView Name, or None.

• Behavior Section - controls the actions and behavior of the QuickView.

— Activation - select the activation mode for the QuickView. Choose from: Selection 
Change or Go Button. This is analogous to the “Activate on Go” button in Diver 6.3 
and earlier.

— Load Value - affects what the initial load value for the QuickView will be when 
opened from a Marker.

Versions prior to Diver 6.4 had two Load Value options: the value(s) Saved in the 
Marker, or a Prompt Dialog. Diver 6.4 introduces 3 new options: First or Last with 
an offset, and Prompt Value. These new Load Value options help to increase 
QuickView performance, and to address the need to change Markers every month due 
to the need for new load values.

• Saved - available in previous versions, selects a specific value or values 
and saves the selection in the Marker. The value(s) will be selected when 
the Marker opens.

• First - new to 6.4, selects the first value in the QuickView, regardless of 
what was selected when the Marker was saved. An optional offset selects 
values beyond the first value. For example, if the first value is selected, and 
offset is “1” the second value is selected. This can be used, for example, 
with a reversed Population Order to open a Marker that selects the previous 
month in a Month QuickView.

• Last - new to 6.4, selects the last value minus the optional offset. This is 
useful, for example, in a Date Marker, when you do not necessarily want to 
see the current date because its data is incomplete, but instead want to look 
at the previous date.
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• Prompt Dialog - available in previous versions, displays a dialog, 
allowing you to select one or more values from the QuickView before any 
Dive windows are created. This is analogous to the “Prompt” option in 
versions 6.3 and earlier.

• Prompt Value - adds a temporary value labeled “Select a Value” to the top 
of the QuickView. Windows associated with this QuickView will be blank 
until a value is selected. “Select a Value” is removed once a valid value is 
selected. Using this option prevents Marker reload when a different value 
is selected.

— Automatically associate with new dive windows - if checked (default), 
automatically associates any new window that gets opened with that QuickView.

This only affects new dives. It is still possible to disassociate the window with that 
QuickView in the Edit Window dialog.

DiveBook QuickViews 2

The Edit Divebook Quickview, changed for Diver 6.4, is shown here:

It contains the following options:

• Name - the name of the QuickView. It will prevent you from creating a duplicate or 
blank name.

• Type - either DiveBook Area or DiveBook Topic.

• Display Type - select from Pulldown, Picklist or Combobox. This is no longer the 
QuickView “Type”, as in 6.3 and earlier, rather an aspect of its display.
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• DiveBook - specify a DiveBook to open if no DiveBook is already open when the 
QuickView is first loaded.

• Activation - select the activation mode for the QuickView. Choose from: Selection 
Change or Go Button. This is analogous to the “Activate on Go” button in Diver 6.3 
and earlier.

• Load Value - affects what the initial load value for the QuickView will be when 
opened from a Marker.

Versions prior to Diver 6.4 had two Load Value options: the value(s) Saved in the 
Marker, or a Prompt Dialog. Diver 6.4 introduces 3 new options: First or Last value 
with offset, and Prompt Value. These new Load Value options help to increase 
QuickView performance, and to reduce the need to change Markers every month due 
to the need for new load values.

— Saved - available in previous versions, selects a specific value or values and saves the 
selection in the Marker. The value(s) will be selected when the Marker opens.

— First - new to 6.4, selects the first value in the QuickView, regardless of what was 
selected when the Marker was saved. An optional offset selects values beyond the first 
value. For example, if the first value is selected, and offset is “1” the second value is 
selected. This can be used, for example, with a reversed Population Order to open a 
Marker that selects the previous month in a Month QuickView.

— Last - new to 6.4, selects the last value (minus the optional offset). This is useful, for 
example, in a Date Marker, when you do not necessarily want to see the current date 
because its data is incomplete, but instead want to look at the previous date.

— Prompt Dialog - available in previous versions, displays a dialog, allowing you to 
select one or more values from the QuickView before any Dive windows are created. 
This is analogous to the “Prompt” option in versions 6.3 and earlier.

— Prompt Value - adds a temporary value labeled “Select a Value” to the top of the 
QuickView. Windows associated with this QuickView will be blank until a value is 
selected. “Select a Value” is removed once a valid value is selected. Using this option 
prevents Marker reload when a different value is selected.

• Automatically associate with new dive windows - if checked (default), 
automatically associates any new window that gets opened with that QuickView.
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This only affects new dives. It is still be possible to disassociate the window with that 
QuickView in the Edit Window dialog.

Diver 6.4 introduces the ability to create DiveBook Picklist QuickViews. In 
previous versions, DiveBook Area and Topic QuickViews could only be 
displayed as a Pulldown QuickView.

List QuickViews 2

New to Diver 6.4, the List QuickView allows improved control over values defined in the 
QuickView. Instead of going against a Model, a List QuickView allows you to specify a list of 
values; for example, a List QuickView named Measures, saved in a parameterized calculation 
Marker might have the values “Plan” and “Actual”. 

When creating a List QuickView Type, its population is specified when defining the QuickView. 
Two choices are presented:

• Specify QuickView values directly in the Edit List QuickView dialog.

• Specify a path to an external file that lists its values.

Values saved in an external text file do not have to be manually added to the QuickView every time 
you wish to create a List QuickView with those values. The External file has one value per row, 
with no header row.

List QuickViews do not specify a Dimension, so using them in parameterized calculations requires 
using the column name.

There are no dependencies or value limits in a List QuickView.

Listed values can not contain carriage returns.

It is possible to have an “All Values” value in a List QuickView using the Include All Values 
checkbox in the Edit List QuickView dialog. This will create an “All Values” value at the top of 
the QuickView, analogous to “All Values” in a Dimension QuickView. If the List QuickView is 
associated with a Dive Window, it will attempt to parse the value (using the List QuickView name 
as the Dimension name) as best it can. If “All Values” is selected, no subsetting will occur.

Note that the Edit Window Info dialog will not list QuickViews whose Dimension names (or in 
the case of List QuickViews, its name) do not coincide with Dimensions in the Model for that Dive 
Window.

List QuickViews may use any of the standard display types: Pulldown, Picklist, or Combobox.
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The List QuickView dialog is shown below.

It has the following options:

• Name - the name of the QuickView. It will prevent you from creating a duplicate or 
blank name.

• Values Section

— List Values - list the values to include in the List QuickView in the text box.

— Values File - browse to an externally created list of values to include in the List 
QuickView.

— Include All Values - include “All Values” in the List QuickView.

• Display Section
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— Display Type - select from Pulldown, Picklist or Combobox. .

• Behavior Section

— Activation - select the activation mode for the QuickView. Choose from: Selection 
Change or Go Button. 

— Load Value - affects what the initial load value for the QuickView will be when 
opened from a Marker.

• Saved - selects a specific value or values and saves the selection in the 
Marker. The value(s) will be selected when the Marker opens.

• First - selects the first value in the QuickView, regardless of what was 
selected when the Marker was saved. An optional offset selects values 
beyond the first value. For example, if the first value is selected, and offset 
is “1” the second value is selected.

• Last - selects the last value (minus the optional offset). 

• Prompt Dialog - displays a dialog, allowing you to select one or more 
values from the QuickView before any Dive windows are created.

• Prompt Value - adds a temporary value labeled “Select a Value” to the top 
of the QuickView. Windows associated with this QuickView will be blank 
until a value is selected. “Select a Value” is removed once a valid value is 
selected. Using this option prevents Marker reload when a different value 
is selected.

— Automatically associate with new dive windows - If checked (default), 
automatically associates any new window that gets opened with that QuickView.

This only affects new dives. It is still possible to disassociate the window with that 
QuickView in the Edit Window dialog.
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Free Entry QuickViews 2

The Free Entry QuickView, also new to 6.4, provides a text box into which you can type whatever 
values you choose. This is useful for driving some parameterized calculations, such as test values, 
or to facilitate “What-If” analysis. The Edit Free Entry QuickView dialog is shown here:

This dialog has the following options:

• Name - the name of the QuickView. It will prevent you from creating a duplicate or 
blank name.

• Default Value - allows you to specify a default value.

• Activation - allows you to select the activation mode for the QuickView. Choices 
include: Selection Change or Go Button. This is analogous to the “Activate on Go” 
button in Diver 6.3 and earlier.

• Text Box Width - allows you to enter the width, in pixels, of the Free Entry 
QuickView text box.

QuickView Sets 2
In the past, there has been a lot of maintenance required to have similar groups of QuickViews in 
multiple Markers. Adding a QuickView or changing any attribute of a QuickView required 
changing every Marker. 

Diver 6.4 introduces a new “QuickView Set” file (.qvs) to store related QuickViews for later use. 
Markers can refer to the QuickView Set file, and if the file changes, the Marker will automatically 
use the new QuickView Set. To save the current QuickViews in a QuickView Set file, select File 
> Save Quickview Set File....

The following types of QuickViews can be saved in a QuickView Set file:

• External Model QuickViews
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• List QuickViews

• DiveBook QuickViews

Using a QuickView Set in a Marker 2

To use a QuickView Set file:

1. Perform the desired dive.

2. Go to File > Save Marker... to open the Save Marker as: dialog.

3. Click the Options button in the upper right corner of the dialog to open the Save 
Marker Options dialog.

If a DiveBook is open when File Save Marker... is selected in step 2 above, you will be 
prompted to save the Marker to a file or to the DiveBook. If saving to a DiveBook, click 
the Options button in the Store Marker in DiveBook dialog, and continue to configure 
the QuickView Set as described below.

4. Put a check next to QuickView Set File, and Browse to the required .qvs file.

5. Select the required file and click Open.

6. Click OK on the Save Marker Options dialog.

7. Back in the Save Marker as: dialog, name your Marker as desired, and click Save.

When that Marker is opened, the contents of the QuickView Set file are used. When a Marker is 
saved with a QuickView Set, no QuickViews are stored in that Marker. 

It is not possible to have a Marker use QuickViews from more than one 
QuickView Set, or use the QuickViews from a QuickView Set plus 
additional non-TimeSeries QuickViews.

Opening or saving a QuickView Set file while a dive is displayed automatically sets the 
QuickView Set File field in the Marker Options dialog to that file.
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Considerations for Using QuickView Sets 2

If a QuickView Set is opened (either explicitly through the “Open File” command, or implicitly by 
opening a Marker that uses one) and a QuickView definition is changed, you will be immediately 
prompted to save the QuickView Set file. Saving a Marker will not prompt you to save the 
QuickView Set file, nor will it save the QuickViews, unless you uncheck QuickView Set File in 
the Marker Options dialog, as previously described.

QuickView Set Files contain QuickView Order objects just as Markers do. These determine the 
order in which QuickViews in the set will be displayed. If Time Series QuickViews exist when a 
QuickView Set file is saved, those QuickViews will appear in the order defined in the Marker, but 
they will not be stored in the QuickView Set file. This means that any Markers that open both 
QuickView Sets and Time Series QuickViews will still display all QuickViews in their proper 
order.

Using QuickView Values in Advanced Find 2
In Diver 6.4, you can use a QuickView value in a Diver Advanced Find string. A new QVVal 
function button appears in the lower-left portion of the button panel in the Advanced Find dialog.

Push this button to insert the term “QVVal( )” into the edit area. The cursor will be set to highlight 
the area in the parentheses. The QVVal term will accept the name of a QuickView and then use the 
value of that QuickView when processing the find. The name of the QuickView should NOT be in 
quotes (“ ”)
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This term should be used in an equation with another term, such as a Summary column. For 
example:

“Units>=QVVal(Threshold)”

If a QuickView by the specified name does not exist, it will return an error.

If the Summary column to which the QuickView is being compared is a number, it will convert the 
string returned by the QuickView into a number.  If the string can not be converted into a number, 
it will return a type mismatch error.
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Chapter 3
DivePort & NetDiver 
Changes 3

DivePort Changes 2
• General improvements for the administrator

— Page editing (see page 3-2)

— Printing Portal Pages (see page 3-4

— Permission Changes (see page 3-5)

— Additional user interface enhancements (see page 3-5)

• Image Portlet changes (see page 3-10)

— Improved document storage and organization

— Automatic migration from version 6.2

— Hotspots where mouse hover presents text

• Measures Portlet changes: (see page 3-17)

— Change Dimension

— Stacked columns

— Even row color

— PDF and Excel Click Actions

• Marker Portlet changes (see page 3-16)

— Change Dimension

— Page Selector positioning
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• Map Portlet Changes (see page 3-16)

• QuickView Portlet Changes (see page 3-21)

• Desktop mobile preview (see page 3-22)

• Slope Indicator (page 3-23)

• Bookmarks (see page 3-24)

• Custom Macros (see page 3-25)

• New Portlet types

— Table of Contents Portlet (see page 3-26) 

— Lookup Manger Portlet (see page 3-28)

— Document Display Portlet (see page 3-30)

Page Editing Improvements 3
With the objectives of creating a less cluttered page, easing dashboard development where there 
are many and smaller portlets, and generally speeding up portal development, certain refinements 
have been made to the user interface.

As the administrator working in an unlocked Page:

• You will see the whole page is slightly greyed, and every editable portlet has a subtle 
rectangular border. Portlets occupy the whole rectangle; no passing through 
transparent regions. Non-editable portlets appear as if they are just part of the page 
background.

• You can hover over each Portlet to instantly see its name (or portlet type if there is no 
name) in a tooltip. Hovering over a portlet highlights it. When portlets overlap, the 
top-most portlet at a given pixel is the one highlighted.

• You can select a portlet by clicking it. You can easily pick out the currently selected 
Portlet since it is highlighted differently than the hover highlight. When only one is 
selected, and it is a manual page, and it is big enough, resize nodes are drawn as well. 
These are the squares located in the corners and sides of the border. Portlets where one 
dimension is 8 pixels or smaller get fewer resize nodes, but there is always at least one. 
You can resize a Portlet instance in any direction by clicking and dragging a resize 
node. You cannot resize Portlets to negative width/height.

• You will notice that selected portlets are considered “on top” for hover highlighting 
and further selection, though are not redrawn on top. Also, if the portlet is large 
enough, you will see a chevron in the top-right for left-click access to the portlet or 
multiple-portlet menu.

• You can drag a selected portlet to reposition it on the page.
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• You can clear a selection by clicking in the page background.

• You will see the chevron for the Page context menu, located next to the lock icon, only 
when the page is unlocked.

While you are editing a Page, you can choose from more click interactions:

• You can double-click a Portlet instance to open the appropriate edit dialog.

• When only one portlet is selected, you can right-click to display and select from the 
Portlet menu (Edit/ Settings, Access/ Copy, Move, Delete/ Move to Top, Move to 
Bottom, Hide for Editing).

• When a portlet is not yet selected, you can right-click to simultaneously select it and 
open the Portlet menu.

• You can double-click the background of a Page to add a new Portlet - the Add Portlet 
dialog displays. 

• You can right-click the background to see the Page edit menu (List Portlets/ Add a 
Portlet).

• You can use Ctrl+C, Ctrl+X, Ctrl+V, and Ctrl+A for copy/cut/paste/select all when 
working with portlets. Portlets added to the page or pasted in become the new 
selection.

• On manual pages, you can press the arrow keys to nudge the selection by one pixel. 
The selection can be a single portlet instance, or a group of portlets.

• On manual pages, you can also use the “Move to Top” and “Move to Bottom” portlet 
menu items to reorder instances.

Additional means to interact with your page elements will speed up page development:

• On manual layout pages, multiple portlets can be selected at one time. You click on a 
portlet instance, then Shift-click or Ctrl-click additional portlets to add or remove the 
targeted portlet to or from the current selection. Selecting and unselecting portlets is 
more obvious because of the change in shading.

• Alternatively, you can click and drag your mouse in the page background to start a 
selection lasso. This can be a quicker way to make multiple selections. While active, 
the lasso highlights all portlets contained entirely within the dotted outline. You can 
also use the Shift or Ctrl keys to add more portlets to the current selection.

• Once multiple portlets are selected, you can select any portlet from the group to select 
the whole group. You will see the same behavior with hover.

• You can right-click on the selection to display the multiple-portlet menu. Here the edit 
choices are: Copy/Move/Delete/Group(Ungroup) Portlets/Move to Top/Move to 
Bottom/Hide for Edit.
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• Once you select multiple portlets, you can click and drag from any of the selected 
portlets, and move all the selected portlets together around the page to reposition them. 
If you also chose to group the portlets, you can perform additional multi-selects and 
groups. You then have several independent groups that can be repositioned on the 
page, while maintaining the relative positions of the portlets within each group.

• For non-manual page layouts, you can select multiple portlets, and edit using the 
multiple portlet edit. 

• For non-manual pages: Portlets can be dragged within their regions, and also into other 
regions. Only one portlet can be dragged at a time. When drag-moving a portlet, its 
edges snap to edges of other portlets.

• To help remove clutter in big dashboards, you can choose to hide portlets while editing 
manual pages. When you first start a page edit, portlets hidden from regular view 
mode (for example, popup-crosslink, hide-until-crosslink) are hidden for editing. But 
you can temporarily hide additional portlets by selecting “Hide for Editing” from the 
Portlet menu. When you do so, an eye icon appears in the upper right. Click it (Show 
Hidden Portlet) to re-display all previously hidden portlet instances on the page.

Printing Pages -WYSIWYG 3
The Print Page feature introduced in DivePort 6.3 allows you to click a printer icon and create a 
PDF of a one-column page layout with Marker, Background, Image, and basic HTML portlets. 

In DivePort 6.4, support has been added for printing pages with manual page layout. In addition, 
support for the Measures, Indicator, and QuickView portlets, plus full support for HTML, are now 
included in the print page feature. 

Users will be able to print the page they are currently looking at and will get 
what-you-see-is-what-you-get results.

The new print page feature requires additional files in the webapps directory, as well as some 
support .dll files. These new files will be automatically installed by the DivePort installer, but they 
may also be installed manually from the DivePort .zip package. For example: 

D:\di_solution\webapps\diveport\executables\webkit\wkhtmltopdf.exe

D:\di_solution\webapps\diveport\executables\webkit\wkhtmltoimage.exe

There are also versions for Linux packaged in the zips.

Also new:

— an icon to produce a .png image of the current page

— an icon to produce a .ppt file containing the .png image of the current page
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These icons will appear on every page that contains portlets, unless you opt out via the Page 
Settings. 

The Page Settings also let you control the page orientation and size.

Changes to Permissions 3
For DivePort 6.3 the scenario is as follows: 

— Rita belongs to two groups in DiveLine.

— She was first assigned to the Temps Group.

— She was then assigned to also be a member of the Development Group.

If you examine the setup in the DiveLine configuration, Rits’a User tab shows she is a member of 
the Groups: Development and Temp, in that order since they are always listed alphabetically.

On the DivePort side, the Development Group is granted User Access to certain Pages. Likewise, 
the Temp Group is granted Privileged Access to the same Pages. 

Rita will only have User Access to those Pages, since the first listed Group’s settings take priority. 
This is less than ideal.

For DivePort 6.4 with the same scenario:

Rita will have Privileged Access to those same pages.

The complete list of Groups a User belongs to, along with the list of Groups given access to an 
Environment, Page, or Portlet will all be considered when determining permissions within the 
Portal. The most permissive access settings take priority.

Additional User Interface Enhancements for the Admin 3
In an ongoing effort to improve the efficiency of the user interface for portal administrators, the 
following changes have been implemented for Diveport 6.4.

DivePort Users and Group admin dialog enlarged 3

Managing a significant list of DivePort users from a very small pixels list is difficult. To help you 
manage your site, the Users and Groups dialogs are now bigger. 

 Create PDF

 Create Image
Create PPT
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List Dialogs now have menus on the left 3

The edit menu icon has been moved to the far left, so it is the first column. The “Name” column is 
now the right-most, where extra characters are less distracting. This includes the List Pages, List 
Portlets and List Environment dialogs.

Clearer indication that Paste was successful 3

In DivePort 6.3, if you copied & pasted an indicator on the same page, it pasted one on top of the 
other, making it difficult to tell if the paste actually happened.

In 6.4, pasting a portlet (or group of portlets) will now offset them from the original. 

If pasting to a different page, the paste will offset from any portlets already on the destination page.

Temporarily hide a Portlet 3

In DivePort 6.3, when adding multiple portlets on a page, it can get messy when portlets start to 
overlap. With 6.4, you can choose to hide portlets temporarily while you are editing the page.

The “Hide for Editing” is on the portlet menu alongside Edit and Settings. You can also access it 
via a right click context menu while in edit mode.

When you are done editing, use the eye icon that appears in the upper right, to show the hidden 
portlets.

Placement of new Portlets in manual layouts 3

Previously, in manual page layout mode, when you added a new portlet it would appear in the 
top-left corner, likely obscuring previously-created portlets. With 6.4, when you add new portlets, 
they will be offset from the top left an increasing amount. For example, if there is already a portlet 
at the upper left corner (0,0), then the next new portlet will be placed at 100,100. If there is a portlet 
there, it will be placed at 200,200, etc. up to 1000, 1000. After that, portlets will appear at 0,0.

Sizing of new Portlets on a Page 3

In the past when you added a new portlet to a page, the portlet container, that is the tan-ish box, 
would default to a 200x200 pixel box, which is seldom the desired size. Starting with 6.4, you will 
notice that the default size for a new portlet will vary by portlet type. In the case of a Marker 
portlet, this would be something like the first full page of a report. This change in the default sizing 
should reduce the need for more edits.

Temporarily Hide Title and Logo Bar 3

The Logo and Title Bar areas are valuable horizontal real estate. Version 6.4 introduces a toggle, 
to the right of the “Edit this environment” menu, that will collapse and expand the Title Bar area 
in the same manner as the SideBar. This gives you the option to skip the Title Bar and Logo area 
and begin your page display with the top level Page Tabs closer to the browser’s address bar.
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Choose between XLS and XLSX output 3

Changes have been made to how the DivePort Excel Click Action exports data to a spreadsheet 
format. In the past, the code produced HTML with a file extension of “xls”. DivePort 6.4 makes 
use of the Apache library “Java API for Microsoft Documents” to output proper XLS files. The 
results are more compatible with newer versions of Excel as well as OpenOffice.

Edit dialogs allow you to choose between xls and xlsx file formats when defining your Excel Click 
Actions.

Download Graphics to Excel 3

In previous versions of DivePort, when you downloaded a report to Excel that included a graphic, 
the word “graphic” rendered rather than the image. In 6.4, DivePort will now put images into the 
generated Excel files, with the caveats:

— only JPEG or PNG

— specified with a full URL

— the URL should be freely accessible (no authentication or proxies)

Changes to the Page Settings edit dialog 3

In the Page Settings dialog, when you use the checkbox for “Print Page ID”, you need to enter the 
ID of the Page to be printed. To avoid confusion, the edit box is now pre-populated with the current 
Page ID. The print Page ID does not have to be the same page that you are looking at, so you can 
enter a different Page ID if desired.

The print page feature allows you to print a DivePort page to PDF. There is now an option to 
choose portrait or landscape layout. You use the source page to set the layout settings for the target 
print page. Click on the new “Print Settings” button in the Page Settings dialog to adjust the page 
orientation.

User Access Log 3

A new log file, diveport-user-access.txt can be generated from ADMIN > Logs. The Download 
Portal Dump button includes this new log file in the portal-dump.zip. It captures the following 
data:

— Username

— Last Access (yyyy-mm-dd hh:mm:ss)

Change to Page load dynamics 3

In the past, DivePort would pause for three seconds before showing any portlets at all, if not all 
portlets were finished loading. Now DivePort displays finished portlets such as backgrounds 
immediately, with Markers appearing later.
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In the past, the wavy-pyramid would appear over the page until all portlets finished loading. Now, 
after three seconds, the wavy flag is dropped and “Loading, please wait...” is inserted into portlets 
that are not yet finished. This means that after three seconds, you can interact with the portlets that 
are finished. Before three seconds, the loading text is not displayed, so the page will not appear 
cluttered as it loads under the wavy-pyramid.

Note that if you are using a mix of Tunnel Markers and QuickViews, it can cause nothing to appear 
until all the Tunnels have finished opening (during which time you get a wavy DI pyramid).

DiveLine Server displayed in Portal Settings dialog 3

As a DiveLine or DivePort administrator, you may have multiple instances of each running on a 
server. It can be cumbersome to figure out what DiveLine goes with which DivePort. Currently 
you can go to the server and check the diveport.xml to figure out which DiveLine is 
connecting to which DivePort. Alternatively, you could check the Dump Portlet. As a time saver, 
“DiveLine Server” is now displayed as a read-only property in the Portal Settings dialog. The 
dialog is also slightly bigger to make the info easier to read.

Control placement of Page Selector 3

When adding a Marker Portlet to a page, you can now specify either a top left placement or a top 
right placement (default) for the page selector, the text box |<< n > >| with the page number that 
appears as needed for multiple pages.

Launch ProDiver or NetDiver directly from Edit Dialogs 3

The Marker, Measures, and certain Indicator Portlet types now have edit dialogs that include 
buttons to launch ProDiver and NetDiver directly. The “Open in ProDiver” icon and the “Open in 
NetDiver” icon appear in the upper right of the edit dialog box.
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This will save time while you are developing your Markers and Pages.

External java script support added to HTML Portlet 3

Previously, DivePort’s HTML portlets did not import external javascript (or CSS) files referenced 
in <script> or <link> tags. 

Now the 6.4 HTML Portlet supports the importing of external javascript. If an HTML portlet 
contains a <script> tag with a src="http://some.external/javascript.js", then 
DivePort will put that javascript in the head of the page, then execute any in-line script tags after 
the external scripts have loaded. An external .js file will be included just once.

Custom CSS supported for Skins 3

In order to build and maintain a skin with a customized look-and-feel, all the DivePort skins now 
have an “includeCssFiles” property. Normally this property is empty, but you can add a 
comma-separated list of CSS file names. For instance:

includeCssFiles=my_css.css, another-one.css

DivePort will search the webdata/<diveport>/customizations/skincss folder for 
those files. Each named file which exists will be appended to the merged CSS file which DivePort 
sends to the browser. Your CSS rules in the files will be at the end, so they override the default 
rules provided by DivePort.
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New Document Library 3

Version 6.4 introduces a new directory structure to organize your various document and image 
files. DI_Solution/webdata/<diveport>/doc-libraries can be used to collect 
files referenced by various portlet types and instances.

Within this directory, the Portal Media folder is accessed by the Image Portlet when saving 
uploaded image files. Portal Media is the official library name and is the only supported library at 
this time (unless you have a special license).

New Portal Media Macro 3

The “PORTAL_MEDIA_URI” macro has been added to make it simple to refer to image files 
located in the standard Portal Media document library.

For example, if you needed to refer to an image you know is in your library while editing an 
Indicator Portlet, you could use $(PORTAL_MEDIA_URI) followed by the filename. The macro 
will expand to:

DI_Solution/webdata/<diveport>/doc-libraries/Portal Media/
<filename>

Image Portlet Changes 3
Several enhancements have been made to improve handling of image files.

Document storage and organization 3
Before 6.4, the Image Portlet had two modes for obtaining the image data to display. Either you 
specified a URL, or you uploaded a file directly. Uploaded files were stored in:
DI_Solution/webdata/<diveport>/portlet-data/image-portlet/
using an encoded name. The file data was uniquely tied to the portlet instance, and the original 
filename was not available to you.

New in 6.4: A URL to an image file may still be specified. However, you now have two other 
choices in the Edit Image Portlet dialog: upload a new image, or select a previously-uploaded 
image. Choosing to upload a new image gives you the opportunity to select a file from your 
computer and to choose the location within the Portal Media document library where you would 
like it to be saved. The default location is:
DI_Solution/webdata/<diveport>/doc-libraries/Portal Media/images/
<filename>
where <filename> is the filename part of the chosen local path.

The open/save-file dialog allows you to specify the save-as destination. It allows you to traverse 
your directories or create new directories. A similar style of dialog is also used if you wish to select 
a previously uploaded file instead of uploading a new one.



Image Portlet Changes DivePort Changes

DivePort & NetDiver Changes 3-11

6.4 CHANGES

Multiple Image Portlets may refer to the same physical file, if all are set to use the same path in the 
Portal Media document library. This also means that if you replace that single image file, then all 
Image Portlet instances using it would reflect the change.

Storage: The “Portal Media” Document Library is a folder in the DivePort webdata area, 
specifically:
DI_Solution/webdata/<diveport>/doc-libraries/Portal Media. 
Images may also be placed at that file system location via other means outside of DivePort (for 
example, in batch using DIAL). This makes it convenient for you to upload groups of files. You 
can use subfolders as needed. These files will be available for Image Portlet use as well. Deleting 
files at this location would make them unavailable to Image Portlets.

Direct URL: If direct access to the image file is desired for use in locations where a URL is 
needed, you can use the macro $(DOCUMENTS_URI) as follows:

$(DOCUMENTS_URI)/Portal%20Media/subdir/filename.png

where %20 is a space character in proper URL-encoded form.

Please note that use of a direct URL is deprecated. If you make use of the document libraries, it 
will make it easier to track down or review all references to an image resource. 

Migration concerns: When an existing portaldb.xml is loaded by DivePort 6.4, it will be 
scanned for Image Portlets configured using an uploaded file. These images will be placed under 
a new Portal Media Document Library, named as they were when they were uploaded, using a 
trailing “(2”, “(3)” etc to prevent name collisions. The process will not automatically collapse 
N-identical copies of the file into one copy. Each migrated Image Portlet will still refer to its own 
physical file. However, the physical files have regained their names and can be reused by other 
Image Portlets in the future.

The old data at DI_Solution/webdata/<diveport>/portlet-data/
image-portlet will not be removed. Thus, returning the same webdata area to a 6.3 DivePort, 
the 6.3 Image Portlets would still operate as before. Once the migration is validated, the
/portlet-data/image-portlet directory can be safely removed.

No attempts are made to migrate Image Portlets using URLs, even if they are using 
$(IMAGES_URI)/.

Image Portlet edit dialog changes 3
The Image portlet upload dialog now allows you to choose the file path and/or directory to which 
a new file is saved. Use the checkbox to replace a file that already exists at the specified location. 

If a file is uploaded to a path that already exists but the replace checkbox is not checked, or the file 
is not editable for ACL reasons, then a number will be appended to the file and it will be saved 
under that name (e.g. “pool.jpg” would become “pool(1).jpg”). You will be informed of the name 
change; it will be used for the image path.



3-12 DivePort & NetDiver Changes

DivePort Changes Image Portlet Changes

6.4 CHANGES

Document libraries are now initialized with Guest as None, except Portal Media, which will 
start with Guest set to User. This allows Image portlets that are migrated from 6.3 and shown on a 
custom login page to continue to work.

Image Portlet resizing 3

Previous to 6.4, the DivePort Image Portlet did not support the re-sizing of an imported image. If 
you had a manual page layout, you could drag the transparent box to resize the frame of the Image 
portlet, but it did not change the size of the image inside the portlet. With 6.4, you now have the 
option to let the image scale to fit the portlet frame.

The Edit Image Portlet dialog now includes a check box which says “Scale Image to fit portlet 
frame”. This is unchecked by default, so the behavior will be the same as in previous releases. If 
you check the box, it will be saved in the portlet preferences and the image will be scaled to the 
smaller of the portlet dimensions relative to the image dimensions. The image will always 
maintain its normal width by height relation and will not be stretched or compressed in one or both 
dimensions. The anchor position of the image is not changed in the frame, but is still anchored to 
the top left (0,0) of the frame.



Image Portlet Changes DivePort Changes

DivePort & NetDiver Changes 3-13

6.4 CHANGES

New Hotspots Feature 3
The 6.4 Image Portlet has a new feature: Hotspots.

The portal administrator may define rectangular regions on the image being displayed and enter 
stylized text to display in a “hover” or “tooltip” when that part of the image is moused-over. You 
can also treat these regions as “rows” and define row-scoped click actions. You can use this feature 
for documentation or additional navigation.

Hotspots work best with an image file that has been edited outside of DivePort to highlight the 
areas of interest.

In the sample above, the orange rectangles have been added to the image file prior to uploading it 
to the portal. You can then use the Hotspot editor to define the rectangular areas to coincide with 
your predefined areas of interest. This supplies the end-users with clues as to where to click for 
more information.

The next screen shot shows the results of hovering the mouse over the Mortality Rate box.
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Using Hotspots 3

When Editing an Image Portlet, click the new button: “Hotspots” to display the Hotspots dialog. A 
sample is shown below.
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This dialog shows the image at right, along with any already-defined hotspots, as indicated by the 
grey boxes super imposed on the image. The left side provides information about and controls for 
the currently-selected hotspot, indicated by the box appearing more grey and opaque than the 
unselected ones. 

• To make a new hotspot, click the appropriately-named button. 

• To change the selected hotspot, click on another the hotspot on the image. 

• To move the selected hotspot, click and drag the mouse. 

• To resize it, click and drag the resize handle at the hotspot’s lower-right. 

• To delete a hotspot, select it and push the delete button.

• To change the hover text displayed for the selected hotspot, type into the Hover text 
area at the left.

• To apply the pulldown edit options, first select the text in the Hover text box, then 
click and select from the pulldown.

• To add Click Actions, click the appropriate button. You can add Info, Help, Web Page, 
or Portal Page Click Actions.

Note that this is a simple WYSIWYG editor. It does however have a pulldown with additional edit 
options, including an “Edit HTML” selection if you would rather enter HTML code directly. The 
HTML is macro-expanded in a hovered hotspot before it is displayed. 

There is also a separate entry to alter the width of the hover text box. When you change the Hover 
width and hit enter, the dialog will alter its appearance so that the Hover Text data entry area is the 
same size as the tooltip width.

An arbitrary piece of text may be entered for the Hotspot Name if desired, or this may be left blank. 
This value can be retrieved in row-scoped click actions using the macro $(ROW_STRING 
“<Hotspot Name>”) and can thus be useful for tying hotspots to Dimension values in business 
data. It can also be used to encode all or part of a Page-ID for portal navigation purposes (with a 
Portal Page click-action and the above macro.) The Hover Text can also be retrieved with the 
ROW_STRING macro.

Note that when defining Click Actions for an Image Portlet, normally only “Portlet” scope is 
available. If any Hotspots are defined, then “Row” and “Portlet and Row” will additionally be 
available. Each hotspot is considered to be a “Row”.
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Change Dimension in Marker and Measures Portlets 3
General and Advanced users can now change Dimensions in Marker and Measures Portlets, if 
enabled on the portlet.

The edit portlet dialogs for the Marker and Measures Portlet types now have an “Allow Dimension 
Changing” checkbox. When you check it, the nearby “Select Dimensions...” button is enabled. 
Click this to specify that either all Dimensions or a subset of Dimensions are to be made available 
to the end-user.

Once enabled, General and Advanced users can click on the header of the Dimension column to 
activate a menu. The menu has “Sort Up” and “Sort Down” (if sorting is enabled for that portlet), 
and then lists the Dimensions that are not already selected in the Marker or Measure. This works 
on non-flipped tables and reports.

Note: When doing a DownLink, CrossLink or Pop-up CrossLink, changing the Dimension will 
also change the Dimension sent in the CrossLink message, so it is probably not a good idea to 
combine those Click Actions with the Change Dimension feature. 

Also note: Launching the Marker in ProDiver or NetDiver will not bring along the changed 
Dimensions.

One final caveat: The column definitions in the Measures Portlet frequently refer to columns by 
name. For instance, if you have added a Sales Region text column, the title will be “Sales Region” 
and the value will be $(ROW_DATA “Sales Region”). If you then change the Dimension from 
Sales Region to Salesperson, the portlet definition will not change (it will still say Sales Region in 
the edit dialog, for instance), but the Measures Portlet renders the column as though it said 
Salesperson. There is a real possibility for confusion here, so tread lightly. Furthermore, if you edit 
the Measures column, it might interfere with the automatic Dimension mapping. For instance, if 
you change the title to “Region”, then it will no longer match the original Dimension name, and so 
the Measures Portlet will not rename it when the Dimension is changed.
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Measures Portlet Changes 3
In addition to the change Dimension feature mentioned above, additional refinements have been 
made to the Measures Portlet.

Stacked Columns in Measures Portlet 3
When you specify the display columns in a Measures Portlet, you can now indicate, with a new 
checkbox, that a column should be stacked with the one listed immediately before it. This may 
facilitate page layout in situations where horizontal real-estate is constrained. This feature allows 
you to stack data from multiple tabular columns into a single column for display purposes. With 
this feature, you could for example, group 8 summary columns from a Marker into 4 display 
columns in a Measures Portlet. Any type of column that the Measures Portlet can display is 
stackable, including Indicators. Some detail specifications follow.

• Column header: The displayed column header will be the name of the first item to 
appear in the column.

• Column width: The column size for stacked columns will be determined by the setting 
on the first item to appear in the column. If this is “auto”, all constituent elements will 
be polled for size to ensure a fit.

• Row height: The height of a row will grow to accommodate all of the items displayed 
in each column. This may leave considerable white space in columns where there is 
less or no stacking. In those cases, the items will be top-justified in their cells. 
Indicators keep their natural size. Images may have explicit sizes set and those will 
continue to be honored.

• Blanks: If an item in a stacked column renders to an empty string, space will still be 
made for it and a blank will appear. The layout is static, not one that dynamically shifts 
elements around according to the data. 

• Sorting: Stacked columns will not be sortable.

• Click Actions and highlighting: Row-level highlighting and Click Actions will 
continue to work. Cell-level highlighting and Click Actions will continue to work. The 
“cell” in this case corresponds to a single item in a stacked column, not the entire set of 
items stacked at that location.
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Even Row Color 3
The DivePort 6.3 skin file had an option for odd row color:

portletMeasuresOddRowColor=rgb(239,239,239)

The even row color was always transparent. With DivePort 6.4, there is now a skin setting for Even 
Row Color.

If zebra striping is turned on (“Show Odd Row Coloring” is checked), then the even rows default 
to the page background color (windowBackgroundColor) in each skin.

If zebra striping is turned off, then the entire portlet background becomes transparent.
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New Measures Click Actions 3
You can now configure Excel Click Actions on Measures portlets. The resulting spreadsheet will 
include all the rows of numeric data in the Measures portlet. The spreadsheet will not include any 
indicators or other graphical elements associated with the Measures portlet.

You can also configure PDF Click Actions for the Measures portlet. The PDF click action makes 
use of the same technology that enables the new print page feature. The full contents of the 
Measures portlet is written to the PDF. The PDF may have more than one page, however, the 
column headers will only appear on the first page.

Map Portlet changes 3
You can now include a user defined title to a map legend. Look in the Edit Map Portlet dialog, in 
the Layer One section of the Property/Value table. The new attribute is “Legend Label”. By 
default, it is blank (no label). Set this value to “auto” to set the legend label to match the name of 
the summary column set in the “Value” attribute; or enter a text string.

The Map Portlet allows you to add a label to each polygon (or point). However, these labels default 
to latitude/longitude values, which does not necessarily make sense on every kind of map. You 
now have the option to instead show a certain Info Field, or column in the Marker the map is based 
on. Look in the Edit Map Portlet dialog, in the Layer One section of the Property/Value table. The 
new attribute is “Info for labels”. 

If you have maps set up for DivePort, you may have noticed after a Tomcat restart, that things slow 
down. The first time you open each DivePort instance on the server may take a while (~10+ 
seconds) for DivePort to refresh its maps and display the login page. This can be avoided by 
requesting a page from DivePort after restarting Tomcat, before your users login. 
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QuickView Portlet Changes 3
Some bug fixes as well as changes to support Diver QuickView enhancements have been 
implemented in DivePort 6.4

Certain Pop-up CrossLinks involving QuickViews fixed 3

Previously, when performing a Pop-up CrossLink with a value that was not in the linked Model’s 
data set, results were unreliable. After some QuickView rework performed for 6.4, if you 
DownLink or CrossLink into a Marker with a QuickView, and the link is sending a value which is 
not present in the QuickView, then instead of showing a different value, the QuickView will 
temporarily add the missing value to its population, select it, and display the Marker with a blank 
window.

Free Entry Quickview Type 3

A new Free Entry QuickView type has been added to the QuickView Portlet. It is simply a text box 
into which you can type a value. This could be useful for driving some parameterized calculations, 
such as test or “what-if” values., or you can use CrossLinks or Tunnel scripts to display a view of 
the data adjusted with the end-user’s input.

The Free Entry QuickView has the following characteristics:

— Name (which will also serve as the label)

— Default Value (this will change if the Marker is re-saved)

— Activation (Go or “Selection Change”)

— Text Box width, in pixels.

Marker Portlets and QuickView Portlets can both display a free-entry QuickView.

All Values: Diver versus DivePort 3

If you have a QuickView based on a Dimension with 20 values and exclude 4 values, then the 
selection list includes 16 values. However, the count for All Values remains 20, since that is what 
is included in the numbers when you click All Values, not the 16 that happen to be selectable in the 
QuickView. That is, there may be 16 choices in the pulldown (plus one for All Values()), but there 
are still 20 items included in the data. 

There was a bug in DivePort, where the All Values was displaying the number of values listed in 
the Quick View after the limits were applied, while Diver continued to display the total number of 
values. This has been fixed in 6.4. DivePort and Diver now have the same behavior, which is to list 
the number of values that will be represented in the resulting window.
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Desktop Preview of Mobile for Administrators 3
An in-browser preview of a mobile site is now available to administrators.

After designating an environment as “mobile”, you will see an additional icon next to the 
page-level unlock icon when viewing pages in that environment. When you click the icon, a new 
window will open, displaying the current page at a small (iPhone-like) resolution, with mobile 
styles enabled and mobile navigation turned on. You can configure the size of the target screen, 
which will also affect the width for displaying the dotted guideline in that mobile environment.

This feature will allow you to easily understand how navigating the mobile environment will work, 
without having to use a simulator or a user-agent changer. The preview icon only appears on pages 
that can display content in the mobile environment, that is four levels down. The Location Bar 
displays [environment name] -> [tab] -> [category] -> [page that can show preview icon]).

Option to go to non-mobile site from smartphone 3

Currently, with your main and mobile sites in two different environments in the same portal, you 
cannot go to the main site with your smartphone, since it always sends you to your mobile 
environment.

With 6.4, you now have the ability to view the main site in non-mobile mode from a smartphone 
by adding the parameter “mobileMode=false” to the URL. 

For example, if your normal diveport site is at https://example.com/DivePort, 

go to https://example.com/DivePort#mobileMode=false on your smartphone to 
see the regular user interface.

If you are viewing a specific page, such as https://example.com/
DivePort#page=a0100, you can add the parameter with a "&", like this: 

https://example.com/DivePort#page=a0100&mobileMode=false

And of course, visit the site on a smartphone without the mobileMode parameter to see the mobile 
version. 
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DivePort vector graphics on mobile devices 3

Previously, DivePort used SVG graphics to dynamically display visual data. These graphics 
displayed as expected on the iPhone and iPad. Unfortunately, vector graphics are not fully 
supported by the mobile browsers on the Android and Blackberry platforms such that Indicators, 
Background and Measures portlets, and clickable graph regions did not display.

With version 6.4, the vector graphics library has been changed to use more compatible technology 
instead. Diveport now use HTML5 Canvas (excanvas.js) to display graphics.

Slope Indicator Portlet 3
A concise graphic indicating rate of change has been added as a stand alone Indicator Portlet, or as 
an option from within the Measures Portlet. It gives an intuitive visual option that takes less space 
than displaying a change rate.

The Slope Indicator graphic is an arrow that shows change visually, as indicated below.

If the change value is 0, the arrow will point directly to the right. If a negative value, it will point 
somewhat down and right. If -100%, then it will point straight down. If a positive value then it will 
point somewhat upwards and right. If 100%, it will point straight up.

You need to set the change value, the minimum value, and the maximum value. The indicator 
arrow shape rotates between pointing straight up (max value) to straight down (min value). When 
at the halfway point, it points to the right. 
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You may also set two optional thresholds and associated colors. The thresholds do not affect the 
angle of the arrow, but will change the color of the arrow when the value is above the high 
threshold or below the low threshold.

Bookmarks 3
A “Bookmarks” feature has been added to DivePort that makes it possible for you to save specific 
views of data and share those views with other users. These Bookmarks record the Page ID and 
any QuickView values. Other users of the portal can see the bookmarks and activate them. When 
selected, the user is taken to the recorded page and the QuickView selections are applied.

You will notice a new icon which resembles a piece of paper with a folded edge in the breadcrumb 
line at the top left of the Page. For example:

The tooltip for this icon is “Open the Bookmark Menu”. You click the icon to display the 
Bookmarks dialog. In this dialog, all bookmarks are listed in alphabetical order. All bookmarks 
are public. You double-click a bookmark (or select it and click Go) to restore the state saved in that 
Bookmark.

The Bookmarks dialog also contains a “Search” feature. You can type text into the search field to 
filter the list of bookmarks to only those bookmarks whose name contains the entered text 
(case-insensitive). Bookmarks which begin with the specified text will be listed first, then 
bookmarks containing the text anywhere in their name. If there is only one Bookmark listed after 
a search, you can hit Enter to activate that bookmark.

The Bookmarks dialog is initially empty of bookmarks. You create Bookmarks by using the 
“Add...” button to display the Bookmark this page dialog where you specify a unique name. 
Bookmarks record the page ID, selections of all QuickViews on the page, as well as the user who 
created it. Only the owner or an administrator can delete bookmarks. You delete a Bookmark from 
the context menu available next to the names in the Bookmarks dialog.

Use Ctrl+B from any DivePort page to display the Bookmarks dialog. 

Use Ctrl+Shift+B to display the Bookmark this page dialog.

Note: Bookmarks do not record DownLink, CrossLink, Pop-ups, or revealed portlets from 
hide-until-crosslink. They also do no record column sorting, Dimension selection in Reporter 
Portlets, the current page number, or the scroll position. Bookmarks change the portaldb.xml, 
so you cannot migrate back to 6.3. 
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Custom Macros 3
A system for user defined macros has been implemented in DivePort 6.4, giving you an easy way 
to define and maintain portal-wide settings. This feature supplements Indicator templates and 
custom Skins by letting you define elements such as a custom name, colors, labels, a size string, a 
directory string, URLs, or a standard error message - which can all then be used universally in the 
Portal similar to existing DivePort macros. For example, you might have a mixture of Indicator, 
Measures, HTML, and Background portlets that all share a single color scheme. You would define 
your color macro once and reference it in the various edit dialogs.

You create macros by using ADMIN > Macros to display the Macros dialog that allows you to 
add, edit, and delete your variables. The syntax for using these defined macros is:

$(MACRO “name of your macro”) 

This is similar to the way the $(QUICKVIEW_VALUE “dimension name”) macro works.

For example, you could define some macros to simplify accessing commonly used paths such as 
HTML_URI, DOWNLOADS_URI. Having these macros simplifies accessing the commonly used 
paths, but also simplifies moving a portal to another location - in which case, you would only need 
to modify the <portal-macros> header section in the portaldb.xml file to reflect the new 
locations.

As another example, you could use a macro to customize the Blank Window Text for all portlets 
in a portal:

— Define the Macro blank_window_text = “No data for this selection.”

— Use $(MACRO blank_window_text) in the Blank Window Text box in the Edit 
Marker Portlet dialog.
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Table Of Contents Portlet 3
While a SiteMap Portlet is useful for quick access to multiple top level Page tabs with numerous 
child pages, the new Table of Contents Portlet allows you to tailor access to selected pages. The 
TOC portlet creates links to each child page below the current page level. You can use multiple 
instances to build a TOC of any number of pages and sub-pages. When you click on an entry, you 
are instantly taken to that page.

The edit dialog for the TOC Portlet has a Property/Value table to allow you to customize the 
number of columns, the font and colors of the background and page names, indentation, padding, 
and other attributes. It eases maintenance of a menu for your end users, since new child pages 
automatically appear in the TOC instance. Hidden pages are not displayed in the TOC.

Creating A Table Of Contents 3
Use the Table Of Contents Portlet after you have created and organized your pages. That way, the 
instance appears with links to the child pages. The Portlet instance only includes links to child 
pages below the current level, so to create a multi-level TOC, you must create the various levels 
and then arrange the instances for your final presentation. For example:

3 TOC Portlets

Image Portlet

Background
portlet
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In this example, the Treeview Sidebar is pinned open to show the child pages. To create the TOC’s, 
you could take the following steps:

1. Use the Superhero Info Page tab as the location for your TOC.

2. Navigate to the Aquaman Page

3. Select the Table of Contents Portlet from the Add Portlet dialog. Click OK to accept the 
defaults. You will see a basic TOC listing the child pages of the Aquaman page.

4. Select Edit > Move. Navigate back to the Superhero Info Page Tab and select Paste.

5. Navigate to the Batman Page.

6. Select the Table of Contents Portlet from the Add Portlet dialog. Click OK to accept the 
defaults. Again, you will see a basic TOC listing the child pages of the current Batman 
page.

7. Select Edit > Move. Navigate back to the Superhero Info Page Tab and select Paste.

8. You would continue to navigate to each child page, create the TOC instance, and move it 
to the main page until complete. Once the instance is relocated to the Superhero Info 
Page, the system updates the instance whenever new child pages are added.

In this example, the basic TOC is enhanced with background and image portlets, while the Status 
attribute in the Title section is set to Hidden.

Additional attributes allow you to adjust the shape and color of the rectangles, realign the title and 
page entries, color every other row, use a fading color effect for the background, and more.
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Lookup Manager Portlet 3
The Lookup Manager Portlet, which requires a special license, allows you to access and modify 
lookup tables stored on the DiveLine server, where these tables can be associated with Diver 
Models using DiveMaster. Lookup files are generally tab-delimited ASCII files. The first column 
holds the unique key needed to retrieve the data in the columns to the right in a particular row. 

• A lookup table is generally a flat file, where the first row contains the column names.

• The first column is the key with data values that correspond to a core Dimension in a 
Model.

• There can be one or multiple columns with strings of text associated with each key 
value.

• Once the key column is named, it cannot be renamed.

• Other columns can be renamed, added, or deleted.

• A lookup table can be associated with only one core Dimension per Model.

• The additional columns appear as Info Fields in the Diver Model, without having to 
rebuild the Model.

When you add a Lookup Manager Portlet to a page, you need to select a Lookup Table file, usually 
one of the following types:

• Text Files (*.txt)

• Lookup Tables (*.tbl)

• Tab Delimited Files (*.tab)
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• Lookup Tables (*.lup)

Use the Edit Mode to specify your preference for edits: either work with individual cells or work 
with a row as a unit. 

Once a Lookup table is added to a page:

— you double-left-click to select and edit the entries in a row

— you right-click to delete a row 

For the table as a whole:

— use the Add Row button to enter a new key and row

— use the Edit Columns button to create, rename or delete columns in the table

Edits made to Lookup tables are saved into the flat files on DiveLine.

In order to use the Lookup Manager Portlet, you must have a license with 
the “LookupManager” feature enabled.
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Document Display Portlet 3
Use the Document Display portlet when you want to display a suitable file from a Document 
Library on a DivePort Page. This functionality requires a Document Library license. It is still 
under development.

A Document Library is a collection of files stored on DivePort under

webdata/<diveport>/doc-libraries/<libraryname>. 

Without a special license, you will only have access to the Portal Media Document Library where 
the images uploaded via an Image Portlet are saved.

With the proper license, you will have access to Admin > Document Libraries which allows the 
creation of more libraries. It also lets you define a set of columns (possibly with constraints) which 
you can use to enter information related to a particular document. This is often called metadata.

The result is a table where the “path” column is the relative filename of the document. Then there 
are optional columns for user-defined data, and record creation and modification info.

This table is stored in webdata/<diveport>/tables/<libraryname.txt> and 
column configuration information is stored in webdata/<diveport>/tables/
<libraryname.xml>.

You can instantiate a Table Editor Portlet to see and edit the contents of these tables. This also 
offers the ability to download the file, or to edit the data associated with it. The Edit dialog will 
display the document, if possible, right in the dialog prompting you for field values. The Table 
Editor portlet is still under development.

The Document Display portlet is as follows.

The Repository ID is the Document Library name, as set under ADMIN > Document Libraries. 
This will eventually have a browse button.

The Attribute refers to the attribute column of the Document Library to query. This will be a 
pulldown showing what is in the library table.

The Value is the value to search for the aforementioned column. This could be the result of macro 
expansion, allowing for QuickView or CrossLink interactions.
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Probably this portlet will gain a simple “pick a file” configuration mode. It is meant to allow a 
query of the document library based on some parameter which could come from a CrossLink or a 
QuickView. The following example just shows the basics.

To create a Document Library:

1. locate your set of files in a folder under webdata/<diveport>/doc-libraries

2. use ADMIN > Document Libraries to use Settings/Access/Edit Forms/Delete as needed

3. use the Table Editor to control display and update of the library

4. use a Document Display Portlet to present a file from the library on a page

Click View document to open the item in the first row of the table above.
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Table 1: Portlet Types

List abbreviation Portlet name

background Background Portlet

benchmark Benchmark Portlet

divebook DiveBook Portlet

docmgr Document Manager

dump Dump Portlet

html HTML Portlet

image Image Portlet

indicator Indicator Portlet

link Link Portlet

logon Logon Portlet

map Map Portlet

marker Marker Portlet

measures Measures Portlet

mockup Mockup Portlet

quickview QuickView Portlet

reporter Reporter Portlet

sitemap Site Map Portlet

sleep Sleep Portlet

toc Table of Contents Portlet

webpage Web Page Portlet
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NetDiver Changes 2
• Advanced Find dialog added

• Improved Console display

Advanced Find 3
NetDiver 6.4 introduces Advanced Find functionality identical to that in Diver. To access the 
Advanced Find dialog:

1. Perform any dive in any Model.

2. Click the Find button in the main NetDiver toolbar to open the Find dialog . 
Notice the addition of the Advanced Find button in the lower right corner of the dialog.
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3. Click Advanced Find to access the Advanced Find dialog, shown here.

This dialog box provides the following features:

• Full functionality to each of the four individual dialog boxes (Find String, Find 
Number, Find Date, and Find Period), in one interface.

• The ability to combine multiple simple find strings into a complex find string across 
multiple columns.

• Additional Find criteria, each described in further detail below.

Find Text Box - location in which you define the Find being done.

Functions - buttons to add various functions to the find definition.

Contains - specify a particular value within the Find string. For example, Sales Region 
Contains “South” would find only values within Sales Regions containing the string “South”.

Begins with - specify a letter value within the Find string. For example, Sales Region Begins 
with “S” would show all Sales Region values beginning with the letter “S”.

Not Empty - find all values in a column that are Not Empty. This option is used on 
Summaries that have some empty cells, in order to filter only those cells that contain data.

N Items (First, Last, First %, Last %) - The Advanced Find dialog box has the ability for 
you to find the First “N” items within each set of a subset of Dimensions in a MultiTab. 

Today - Enter Today’s date, as defined by the client system, into the Find string.

Date - Enter a specific date into the Find string.
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Period - Enter a specific period into the Find string.

An example of how to find the First “N” items within each set of a subset of Dimensions in a 
MultiTab follows.

1. Dive on Sales Region.

2. MultiTab with Product Family to create the following Dive Window:

3. In the Advanced Find dialog box, type First(2,Product Family) and click Find 
All.
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4. The first two Product Families of each Sales Region will be found, and the resulting dive 
will look like this:

The Find string can take any number of dependent columns. For example, if you want to find the 
first two Products by Sales Region, Month, Salesperson, and Business Type, you can do so. It will 
find the first N rows for each unique combination of values for those four columns. 

When only one column is specified in the string, it will use the column just to the left of that 
column in the window as the one dependent column. For example, in the two-column MultiTab of 
Sales Region and Product Family, the find strings “First (2, Product Family)” and “First (2, 
Product Family, Sales Region)” are equivalent. If the MultiTab instead contained Sales Region, 
Month, and then Product Family, “First (2, Product Family)” would find the first two Products for 
each Month instead of for each Sales Region. 

The Find is independent of sort order. It does not consider how the value of the dependent columns 
change, it only tracks the number of times each unique combination of those values has been seen. 

All the columns used with the “N” Find functionality MUST be Dimensions (core or dynamic) 
because the Find depends on having key values. In addition, any columns used must be present in 
the current Dive Window. This functionality will work in MultiTabs and MultiCrossTabs, but will 
not work in Tabulars or CrossTabs.
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